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1. Introduction 

The IP Post-Process software developed by Instrumentation GDD allows you to visualize 
collected fullwave raw data, but also the stacked readings and the chargeability decay (M) 
for each acquisition channel. You can also visualize the Pseudo Section of your original and 
processed IP data, for each Rx-Tx line combination. In addition, you can choose between 
the GDD Noise Rejection algorithm or manually discard noisy half-cycles, enhance your Rx 
– Tx synchronisation, modify the Windows Scheme and deactivate from individual channels 
to entire readings. Furthermore, data from multiple receivers can be merged, original files 
can be re-processed with a transmitted current file (collected with GDD’s EM-IP Tx 
Controller) to improve apparent resistivity calculation. Also, the telluric noise can be 
removed from survey data using data collected at a remote station. 

Once your data has been post-processed, you can generate new output files (*.gdd, *.dat, 
*.csv, *.gps, *.fullwave & customised formats). These are compatible with a wide range of 
third-party data analysis and inversion software. Custom filter functions can also be 
implemented on demand. 

 

2. Release Notes 

Version 1.2.X is no longer a release candidate (RC). The software has been tested by 
numerous clients and improved consequently. We still invite all our clients to report any 
problems encountered with the IP Post-Process software (other than the known limitations 
listed below).  

 

Main updates 

1.2.0 Pseudo Section panel; 
Export project directly from an original *.mem file; 
Possibility of modifying the Tx current using a fixed value. 

1.2.1 Merge of multiple *.mem files. 

1.2.2 Telluric rejection option (*.bdf file, Telluric panel); 
Custom export file format editor; 
Possibility of modifying the Duty Cycle (DC = 50% or 100%); 
Measurement of chargeability (M) during ON Time (DC = 100%). 

1.2.3 Discard individual channels or a complete reading; 

Improvements to Pseudo Section and Synchronization algorithms. 
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1.2.4 Synchronization mode “Quick"; 

Improvements to Pseudo Section. 

1.2.5 Synchronization mode “Enhanced" removed; 

Synchronization mode “Quick" renamed in “Auto”; 

Synchronization mode “Auto" made default; 

Detailed data presentation text mode. 

1.2.6 Processing of SCIP’s data files. 

Import Windows Scheme from memory file. 

1.2.7 Multiselecting and auto matching of .IFI files for selected readings 
in the filter. 

Option “Auto adjust zoom” prevents from changing graph’s zoom 
between readings. 

1.2.8 Multiselecting and auto matching of .BDF files for selected 
readings in the filter. 

Option “Enabled for post-processing” in the filter. 

1.2.9 Editing positions in the filter allows to re-calculate the apparent 
resistivity (Rho). 
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3. Installation 

The IP Post-Process software can be used with GDD’s IP receivers and EM-IP Tx Controller 
datasets. The software is compatible with Windows XP, 7, 8 and 10. When installing the 
software for the first time, you will get 30-days license activation. 

In order to get your full license, you will need to send an activation request by internet to 
Instrumentation GDD. 
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The IP Post-Process software requires that the following applications are installed on your 
computer: .NET Framework 4.6.2 and Microsoft Visual C++ 2017 Redistributable (x86). The 
installation of these two applications is included when installing the IP Post-Process 
software. 

 

 

 

 

 

Once the installation is successful, you will have a 30-day license. 
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In order to extend your license for a longer period, please fill the Licensing Activation form. 
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4. Software overview 

Main Window 

 

 

The Main Window is divided in three sections: 

 Menu Bar: File, View, Tools, Window and About 
 

 Task Bar/Graphic Bar: My Project and Graph Options 
 The list of the Linked file will display the current *.ifi (from 
GDD EM-IP TX Controller) and remote reference *.bdf (from 
stand-alone GDD IP Receiver) imported files. These files can be 
imported from the Data Filter Editor (section 8).  

 

 Data/Graph Window: Data, Raw, Stack, Decay, Telluric and Pseudo Section panels 
 The tabs or panels will become available or not according to 
the type of data and processing being undertaken.  

  

Data/Graph 
Window 

Task Bar/Graph 
Bar 

Menu Bar 
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Menu Bar 

Use the Menu Bar to access software options and settings. 

File menu: 

Allows basic command such as opening a Project or File (recent or new), Save and Close. 

 New Project: Create a project by importing one or multiple binary GDD IP Rx *.mem 
files. Post-Process options will only be available through a project. 
 

 Open: Open an existing Project (*.ipp), a binary file (*.mem, *.ifi, *.bdf) or a 
*.fullwave ASCII file (from a GDD IP receiver or a GDD SCIP Tester). Note that you 
need to generate a project to be able to process your dataset. The “Open \ file” will 
only enable display options. 
 

 Export: Save your processed (filter) files in GDD (*.gdd, *.fullwave, *.gps), Amira 
(*.dat), Prosys (*.csv) or Geosoft (*.dat) ascii format. It is also possible to customize 
the export format. Note that the file to be exported will be the one activated in the 
Data/Graph Window (active tab).  
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View menu: 

To hide \ open the graph tool box, use the View->Show/Hide ToolBox option. 

 

The tool box will appear to the top right of the Data/Graph window as followed for the Raw, 
Stack, Decay and Telluric panels. Note that the “Half Cycle Selection” and the “Delay and 
Period modification” are only enabled in the Raw panel of the Post-Process (filter) data. 

 

 

 

 

 

 

 

 

Customize column: define information to display in the Data window. 

 

 

 

 

 

 

 

 

 

 

 

 

Add/Remove Decay buttons allow to add or remove all decay windows M01, M02, M03 … 
M20 together.  

Pan mode (Default) 

Pan mode with (x,y) data value 

Zoom in mode 

Zoom out mode 

Half Cycle selection (with Stacking Algo set to Average) 

Delay and Period modification (with Sync. set to Manual) 

Reset Zoom (Extents) 
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Tools menu: 

Window Scheme: open the Window Scheme Editor. This feature allows changing the size of 
the window (initial delay and width), visualizes the resulting windows on a graph and 
creating new schemes.  

 

 

 

 
Note that the "Delay" refers to the time between the beginning of the OFF-time and the 
start of the first-time window. The "width" is the time window’s width. All windows are 
contiguous. Refer to section 8.3 for additional information. 

  

Add a new Windows Scheme 

Save current Windows Scheme 

Import a Scheme 

Export current Scheme 

Import Windows Scheme from data file (*.mem) 
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Window menu: 

Change the appearance of the opened graphical windows. 

 

This is an example of a processed file and the corresponding original *.mem file in the Tile 
Vertical format: 

 

About: 

Displays the current version of the software, remaining license time and the possibility to 
renew license before expiration. 
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Task Bar 
The Task Bar gives information on the project, processed files and current / remote 
reference files. 

 

 

  

Edit this filter 

Project name 

*.mem file 

Processed files or Filter 

Add Filter button 

Active Current / 
Remote reference  
files in Project 

Delete this 
filter 
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Graph Bar 
The Graphic Bar provides a search tool for the Data panel (right) and display options for the 
Raw, Stack, Decay, Telluric and Pseudo Sections panels (left). 

 

 

  

Reading to be 

displayed in the 
Raw, Stack, 

Decay and Telluric 
panels of the 

Graph Windows 

Y axis 
settings 

Displayed channels 
(up to 32) 

X axis 

settings 

Display current 

file associated 
to IP readings 

Select \ Unselect  

all Channels 

Change or not 
graph’s zoom 

while 
changing 

readings 

Display channel-specific 

data (Vp, Sp, M, Decay …) 
in the table 
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Data/Graph Window 
The Main Window allows visualizing data and graphs for each of your opened files and 
active filter files.  
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Data: Spreadsheet displaying every reading included within the active *.mem or 
 *.fullwave file. Note that the data to be displayed will slightly differ if it comes from 
 an IP receiver or a SCIP tester; 

Raw: Fullwave raw primary voltage data in volts, available for every active input channel; 

Stack: Averaged half-cycle (ON+, OFF) in volts. Computed from our GDD noise rejection 
algorithm or manually, using the half-cycle rejection tool. This panel is not available for files 
opened outside a project or a filter. 

Decay: Off-time chargeability Decay (in mV/V). Not available for *.fullwave files;  

Telluric: Raw signal collected at a remote reference station from a *.bdf file. Only the signal 
of the two (2) first active receiver channels will be displayed and considered for processing. 

Pseudo Section: Pseudo Section of Apparent Resistivity and Chargeability of each surveyed 
lines. 

Note that by double-clicking on any current *.ifi or remote reference *.bdf file from the 
Linked files menu, a new window will appear with the corresponding data file displayed. 
These files are generally voluminous and may take time to be loaded. 
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5. Getting started 

Create a new project 
• Save your data files to your computer: 

o *.mem files from GDD IP receiver 

o *.ifi files from GDD EM-IP Tx Controller 

o *.bdf files from your remote reference station (GDD IP receiver) 

• Start the IP Post-Process software by clicking on the software icon . 

• Create a project by selecting File->New project… 

 

• Browse to the folder containing your data and open the binary data *.mem file(s). The 

following window will appear, click on OK once your project name is typed. 

 

• The project name will appear in the Task Bar. 

 
 

• It is possible to create a project using more than one *.mem file (collected using one 

or more IP receivers. To do so, copy all the *.mem files in the same directory and select 

them all when creating a new project. A “file Group” will then be created. 

  

Project 245 
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6. Visualizing your Data 

Double click on the file name (*.mem file or filter) in the project task bar. This may take 
some time depending on the size of your *.mem file.  

DATA panel 
The following window will appear with the DATA tab opened. This table is a simple 
representation of the original *.mem file with columns displayed as per what has been 
selected in the View\Customize Column menu. Select a reading in the DATA table that will 
be displayed in the graphical windows. If you have loaded more than one *mem files, the 
merged dataset will be displayed. 

 

 

 

The search bar in the Option Bar allows you to quickly find readings by their number or 
custom properties. 
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If you select “Display channel-specific columns” option, the detailed Data table is shown. 

You can see Vp, Sp, M, Decay and other parameters per channel, according to the settings 
made in the View\Customize Column menu. 

The “Display channel-specific columns” option is deactivated by default, because it takes an 
extra time to display details. 

  



 

Instrumentation GDD 2023-07-17 Page 20 

 

RAW panel 
Open the RAW tab to visualise the fullwave *.mem data. All sampled data points from the 
GDD IP receiver are saved in the *.mem file. 

 

For a Filter file, if a Remote Reference *.bdf file has been associated to a *.mem file (one or 
more readings), the data displayed in the RAW panel will then be the processed with telluric 
signal removed. The correlation factors used for the telluric removal calculation can be 
exported using the Export Format Editor (Remote Correction). 
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The Zoom Editor window at the bottom of the graphical window allows panning and 
zooming the content of the main window. Drag the edges of the blue rectangle to zoom on 
the selected area of the signal. You can also use the ZOOM tool located in the upright 
corner. Use the graph task bar to the left of the screen to navigate through the readings, 
set axes limits or show / hide specific channels. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Disable “Auto adjust zoom” option, if you want to apply the selected zoom while changing 
readings. Otherwise, the zoom will be adjusted automatically, if you choose another reading 
to be shown. 
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STACK panel 
Click on the STACK tab to display the stacked data. The stacked panel is only available for 
Post-Process files (filter). 

 

The Zoom Editor window at the bottom of the graphical window allows panning and 
zooming the content of the main window. Drag the edges of the blue rectangle to zoom on 
the selected area of the signal. You can also use the ZOOM tool located in the upright 
corner. Use the graph task bar to the left of the screen to navigate through the readings, 
set axes limits or show / hide specific channels. 

Disable “Auto adjust zoom” option, if you want to apply the selected zoom while changing 
readings. Otherwise, the zoom will be adjusted automatically, if you choose another reading 
to be shown. 
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DECAY panel 
Open the DECAY tab to display the Off-time chargeability Decay (in mV/V). Not available for 
*.fullwave files. In order to plot both positive and negative values on the same graph, a 
linear transition is created around zero when the logarithmic scale is selected.  

 

 

The Zoom Editor window at the bottom of the graphical window allows panning and 
zooming the content of the main window. Drag the edges of the blue rectangle to zoom on 
the selected area of the signal. You can also use the ZOOM tool located in the upright 
corner. Use the graph task bar to the left of the screen to navigate through the readings, 
set axes limits or show / hide specific channels. 

Disable “Auto adjust zoom” option, if you want to apply the selected zoom while changing 
readings. Otherwise, the zoom will be adjusted automatically, if you choose another reading 
to be shown. 
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Pseudo Section panel 
Open the Pseudo Section tab to display the Pseudo Section of each surveyed lines. Both 
Apparent Resistivity and Chargeability Pseudo Section can be displayed. Note that it can 
take some time for the software to compute the Pseudo Section of a filter file.  

The Graph Options allow to set manually the X and Y axis values. There are also graphical 
options such as displaying and defining the contours and the color range. 

 

The Zoom Editor window at the bottom of the graphical window allows panning and 
zooming the content of the main window. Drag the edges of the blue rectangle to zoom on 
the selected area of the signal. You can also use the ZOOM tool located in the upright 
corner. Use the graph task bar to the left of the screen to navigate through the lines, set 
axes limits or define custom colors range. 

Disable “Auto adjust zoom” option, if you want to apply the selected zoom while changing 
lines. Otherwise, the zoom will be adjusted automatically, if you choose another line to be 
shown. 
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In the Pseudo Section panel, when using the Pan mode with (x,y) data value , the X 
value refers to the survey station, the Y refers to the graphical vertical position of the data 

point from the electrode spacing (does not 
corresponds to a true depth) and Value returns the 
Resistivity or Chargeability result at this survey 
station. 

Note that intermediate values used in the pseudo 
section interpolation will be displayed using this Pan 
mode. These values are not considered in the 
exported datasets. 
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Telluric panel 
The Telluric panel will be available if one or more remote reference *.bdf files have been 
associated to the *.mem readings. In which case, the data displayed in the RAW panel will 
then be the processed data with telluric signal removed. The correlation factors used for 
the telluric removal calculation can be exported using the Export Format Editor (Remote 
Correction). 

 

The Zoom Editor window at the bottom of the graphical window allows panning and 
zooming the content of the main window. Drag the edges of the blue rectangle to zoom on 
the selected area of the signal. You can also use the ZOOM tool located in the upright 
corner. Use the graph task bar to the left of the screen to navigate through the readings, 
set axes limits or show / hide specific channels. 

Disable “Auto adjust zoom” option, if you want to apply the selected zoom while changing 
readings. Otherwise, the zoom will be adjusted automatically, if you choose another reading 
to be shown. 



 

Instrumentation GDD 2023-07-17 Page 27 

 

7. Modifying your survey parameters 

To re-process your data, select your *.mem file or file group and click on the Add Filter Icon 

 in the task bar. 

 

 

The Filter Editor will appear. The left part of the window contains the parameters controls 
while the right part recalls the readings information. 

To modify a parameter, you must first select one or more readings. To do so, you can click 
directly in the corresponding reading(s) to highlight it (to select more than one reading, hold 
the Ctrl button while clicking on the readings). You can select all the readings by clicking on 
the top left corner of the data window. 

You may now change the following survey parameters: 

  

Auto 

7 

2 

1 

3 

4 

6 

5 

8 
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7.1 Tx Current 
Changing the current (constant or *.ifi file collected using GDD’S EM-IP Tx Controller) will 
modify the apparent resistivity (Rho) accordingly. The use of a current file (*.ifi) will result 
in a very accurate Rho calculation.  

When a current file is associated to a reading, it can be displayed in the Raw panel. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

You can select multiple *.ifi files and apply it for multiple readings in the filter. Based on the GPS 
time, the filter will automatically find the match between *.ifi files and selected readings and 
warn you with the number of readings for which the match wasn’t found. 
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7.2 Stacking algorithm 
The Stacking algorithm will allow computing the final stack half-cycle. You can choose 
between the default stacking algorithm GDD “Noise rejection” or the “Average” mode. The 
latter will allow you to un-select undesired half-cycles and to re-compute the stack. 

 

 
 

When using the “Average” mode, click on the half-cycle selection icon and highlight (in pink) 
the half-cycle to discard from the final stack calculation. Discarding a half-cycle implies that 
every channel will be discarded. 

 



 

Instrumentation GDD 2023-07-17 Page 30 

 

7.3 Windows Scheme 
The Windows Scheme is set to sample the Vs decay for chargeability calculation purpose. 
This IP Post-Process software provides the user with an interface to modify the Windows 
Scheme used during acquisition with very little limitations. 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
All non standard windows schemes used while acquisition and stored in the data file (.mem) 

are unnamed. When you click the “Import scheme” button , the software searches 
for the match between windows schemes on the list and the windows schemes in the data 
file. If a match is found, the software applies the name of the windows scheme on the list 
to the windows scheme in the reading. If no match is found, the user is asked to name a 
new windows scheme and this one is added to the list. 

  

To open the 
Windows 

Scheme Editor 

To import a 

scheme from 
the data file 

(.mem) 
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7.4 Synchronisation 
The synchronisation of the data collected at the IP receiver in regards to signal emitted at 
the transmitter can be modified using this post-process option. 
The step of validating the data synchronization is very important since it will impact on 
your post-processed Vp and Chargeability results. 
 

 
 

By default, "Auto" is selected and the Post-Process software find the synchronisation itself. 
The software uses fullwave and applies a more sophisticated algorithm then the one in the 
receiver to find a more accurate synchronisation. Generally, it is the best option. 
You can choose the trigger channel used for synchronisation. 
 

 
 
Normally, it should be the channel with the strongest signal. 
 
If "Not Set" is selected, the Post-Process software uses the synchronisation found by the 
receiver while acquisition. 
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In order to use the "GPS" synchronisation mode, your IP data must have been collected 
from a GDD IP receiver and IP transmitter (with GDD EM-IP Tx Controller) both synchronised 
using GPS signal.  
 
The "Manual" mode allows setting the "initial offset (ms)" and "Half cycle width (ms)" which 
correspond respectively to the beginning of the first ON-time and to the cycle duration (time 
base). Note that a slight adjustment of the “time base” actually refers to adjusting the 
number of samples in each half-cycle. The Duty Cycle menu can be accessed in “Manual” 
mode only. If required, it can be changed from 50% to 100% or vice versa. 
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You can visualize the synchronisation parameters (i.e. Initial offset and Period) in the RAW 
panel as red vertical bars by clicking on the "Delay and Period modification" icon in the Tool 

Bar: . You can then manually adjust the initial offset by dragging the first bar and the 
period with the other ones. 
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The STACK panel will help validating your IP data synchronisation. For a conventional 50% 
duty cycle survey, The ON-time and OFF-time cycles should be of the same duration than 
half of the survey time base. 
 

 
 

 

  

Accurate 
synchronisation  

Example of an inaccurate 
synchronisation  
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7.5 Remote reference 
To cancel telluric noise from a Resistivity / IP survey dataset, start by creating a new project 
using your survey *.mem file. Next, add a new Filter file. From the Data Filter Editor, select 

and associate a Remote reference *.bdf file using  to each of your readings. Generally, 
a single .bdf file will be measured for the entire .mem dataset and thus the entire set of 

readings can be selected by clicking . 

You can select multiple *.bdf files and apply it for multiple readings in the filter. Based on 
the GPS time, the filter will automatically find the match between *.bdf files and selected 
readings and warn you with the number of readings for which the match wasn’t found. 

Apply the telluric correction by clicking on “Apply Filter”. 

 

Refer to the example below for which Remote reference file “test_tell_20170214.bdf’’ has 
been associated to Reading 2 of the “GDDRx_PP_MEM.mem” IP survey file. 
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The “New Filter” processed file will allow the display of a new panel (i.e. Telluric) on which 
the Remote reference data (from *.bdf) corresponding to the survey period will be plotted. 
In the example presented here, the Remote reference station included two (2) orthogonal 
dipoles (channels 1 and 2). 

 

 

 

 

 

 

 

 

 

 

 

 

 

The RAW panel of the Filter file will display the processed result with Telluric noise collected 
at the Remote reference station extracted (refer to section 7). Figure below presents the 
original RAW data (left) against the processed file (right). 
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The correlation factors resulting from the Telluric noise cancellation can be exported using 
the Export Format Editor (refer to section 5). Select the following exported columns: “Remote 
refence” and “Remote Correction”. 

 

 

7.6 Positions 
 

Editing positions is possible for the following modes: Dipole-Dipole, Pole-Dipole, Pole-Pole, 
Gradient and Distributed. This function has been added in order to help you to fix the 
positioning errors occurred while doing survey in the field or to put more accurate 
positions from the GPS after the survey. 

To put your custom positions in the Filter Editor, change the Positions from Initial to 

Custom and click the  button. 

 

 

 

 

 

 

The following window will be opened, allowing you to edit positions. 
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If you confirm the modifications, the apparent resistivity (Rho) will be recalculated and 
shown in the Data tab of the filter. The Pseudo Section will be also updated. 

If you want to create an output file (*.gdd, *.dat, *.csv) with modified parameters, do the 
Export Project for the selected filter. 
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7.7 Enabled for post-processing 
 

Disabling a complete reading is possible while creating a filter. 

Select the readings you want to discard from the final dataset and uncheck the following 

option . 

Once disabled, the corresponding RAW, STACK signals and DECAY curves will be displayed 
as dash line to indicate that they are no longer activate and the Pseudo Section will be 
adjusted accordingly. 
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7.8 Apply Filter 
To save your filter, give it a "Post-Process" name (top left of the Data Filter Editor) and click 
on the "Apply Filter" button. A new file will appear in your Task Bar. Double-click on it to 
activate a tab in the Data\Graph window and navigate in the Data, Raw, Stack, Decay and 
Pseudo Section panels to visualize the results. 

At any time, you can modify a Post-Process file by clicking on the corresponding edit 

button or you can delete it using the  remove filter button in the Task Bar. 

 

7.9 Disabling a reading 
Disabling a complete reading is possible once a filter file has been created. Go to the DATA 
panel of your filter file and uncheck any reading to be discarded from the final dataset. 
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Once disabled, the corresponding RAW, STACK signals and DECAY curves will be displayed 
as dash line to indicate that they are no longer activate and the Pseudo Section will be 
adjusted accordingly. 
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7.10 Disabling a channel 
Disabling a channel is possible in the RAW, STACK and DECAY panels using the Channel 
display tool of the Graph Options: 

 

 
Right-Clicking on any of the available channels will activate a menu with two options: Hide 
or Disable. 

 

 

If a channel is hidden, it will no longer be displayed in the RAW, STACK and DECAY panels 
but will still be included in the final database. On the other hand, if a channel is deactivated, 
it will be displayed as a dash-line in the panels so you know it is no longer part of the final 
dataset. You can deactivate one or more channels of each Filter file reading. 

 



 

Instrumentation GDD 2023-07-17 Page 43 

 

  

 

 

  

Original *.mem file 

Decay Panel 
with 

CH2(red) 

disabled and  

CH3 (pink) 
hidden 

Visual aspect of a 

channel being 
deactivated 

Visual aspect of a 

channel being 
simply hidden 

Processed Filter file 

Decay Panel 

of 5 active 
channels 
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8. Technical Support 

If you encounter a problem not described in this manual, do not hesitate to contact 
Instrumentation GDD for assistance at: 
 
Tel.:  +1 (418) 478-5469 
 
e-mail:  info@gddinstruments.com 
 

 


